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How to create WBS of your project

Taks, durations and linkages between tasks

Project Management

Time estimations for project activities




How the lecture will be conducted?

1.

The lecture 1s divided into three blocks, where each block introduces
an 1ssue (1. Project planning, 2. MS Project WBS, 3. MS Project tasks
and durations)

After each block there is a quiz for feedback on whether you have
understood everything.

We use MS Teams, a shared whiteboard for your engagement and
reactions. Also we are working with MS Project.

The class 1s supplemented with quizzes in vevox, the link 1s always in
the presentation.
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1. PART 40 min)

* Project planning, theoretical overview.

2. PART (20 min.)
* MS Project WBS, introducing the WBS in MS Project.

3. PART 30 min.)

* MS Project tasks and durations, demonstration of how to create tasks,
define the duration of each task.
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After studying this topic, you should be able to: scout oF TS
* Divide the project into subparts.
» Using the Work Breakdown Structure.

* Learn how to use WBS in MS Project.

* Create tasks and define their times in MS Project, working with Gantt chart.
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You can ﬁnd SuppOI’t iIl the fOllOWing Sources. ADMINISTREATION IN KARVINA

* Book — Chatfield and Johnson (2016). MS Project 2016 Step by Step (Part 3 Start a new plan, Part 4
Build a task list)

* Book — Heldman, K. PMP Project Management Profesional Exam — Study Guide (2013). Chapter 3
(Creating the WBS, Plan Scope Management)

MS Project Tutorials — basic setup, tasks:
e https://www.youtube.com/watch?v=sYv-iFzz1Eo

* https://www.youtube.com/watch?v=tuCrTKMPu_Y
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PART 1

Typical problems with developing objectives
Project planning include:

* Project objectives/goals are not agreeable to
all parties.

* Project objectives are too rigid to
accommodate changing priorities.

* Insufficient time exists to define objectives
well.

* Objectives are not adequately quantified.
* Objectives are not documented well enough.

* Efforts of client and project personnel are not
coordinated.

* Personnel turnover is high.




Project Planning

These information requirements are:

* The statement of work (SOW)

* The project specifications

e The milestone schedule

* The work breakdown structure (WBS)

* The statement of work (SOW) 1s a narrative
description of the work to be accomplished. It
includes the objectives of the project, a brief
description of the work, the funding constraint if
one exists, and the specifications and schedule.

Tasks

Schedules

Standards and testing

Project Requirements

Definition of Success

Payment Terms

Signature

Date

Project Sponsor
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Tasks include developing a website on WordPress, redesigning the Homepage and
getting Michel's approval. Once the design is approved, the task is to redesign the other
six pages based on that.

Design on staging environment should be set up by March 18, 2021, Implementation of
final design should be made live by March 23, 2021,

This project has no industry or compliance standards. The Infosystems will run tests
on the staging environment before it is deployed.

Infosystems will use their resources to build the communication website

The communication website must be built on WaordPress with an appealing and easy to
use design.

A payment of USD 8,400 will be wired upon the final delivery of the project.
Infosystems must have a W-9 on file before a payment is made

Signature
Date

Senior Manager



Project Planning

* The successful accomplishment of both contract and
corporate objectives requires a plan that defines all effort to
be expended, assigns responsibility to a specially identified

* Organizational element, and establishes schedules and
budgets for the accomplishment of the work.

* Development of the work breakdown structure (WBS). A
WBS is a product-oriented family tree subdivision of the
hardware, services, and data required to produce the end
product.
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Example of a Delivered-Base Work
Breakdown Structure for Construction

Single Family Home

Utilities
and Systems

Finishes and
Envel
s 5

Design and Frame, Beam:
Architectural Ties, Trusses
Rendering

8l
Specifications




Project Planning

* Preparation of the WBS also considers other
areas that require structured data, such as
scheduling, configuration management,

contract funding, and technical performance
parameters.

Work Breakdown Structure Tree
Diagram Template

Construction Project by Phase

11
. 21 3.1 3.2
m m scheullle m
documents

111 211 2.21 2.31 311 3.21
Scope Excavate Framing Drywall

4, Closeout
41
Occupancy
Permit

331
Milestones Cost Site

accounting Inspection

411 4.21 4.31
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Work Breakdown Structure Tree

1.2.1

Formwork

1.2.2
Rebar

1.2.3
Cement

211
Steel
frame

21.2
Windows

2.1.3
Exterior
doors

Diagram Template

Commercial Building

1. Site Pre .
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Project Planning

Although a variety of work breakdown structures exist, the
most common is the six-level indented structure.

The work breakdown structure can be used to provide
the basis for:

The responsibility matrix
Network scheduling
Costing

Risk analysis
Organizational structure
Coordination of objectives

Control (including contract administration

Managerial
levels

Technical
levels

Level

L b

A

o)l
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Description
Total program
Project
Task

Subtask

Work package
Level of effort



Project Planning

Work breakdown structure for objective control
and evaluation

The WBS must be accompanied by a
description of the scope of effort required, or
else only those individuals who issue the
WBS will have a complete understanding of
what work has to be accomplished.
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Validates total
risk and impact of
decision-making

Validates time
and schedule

Validates

Validates management organization charts

coordination

Interlocked
objective
networks

Feeder objectives

packages

Validates work
methods and
accountability

Cost flow
objective network

Validates total
costs

Source: Kerzner, H. 2017. Project Management
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* Have clearly defined start and end dates
* Be usable as a communications tool in which results can be compared with expectations
* Be estimated on a “total” time duration, not when the task must start or end

e Be structured so that a minimum of project office control and documentation (i.e., forms)
1S necessary

For large projects, planning will be time phased at the work package level of the WBS.
* The work package has the following characteristics:
* Represents units of work at the level where the work 1s performed

* C(learly distinguishes one work package from all others assigned to a single Functional
group

* Contains clearly defined start and end dates that are representative of physical
accomplishment

* Specifies a budget in terms of dollars, man-hours, or other measurable units



Project planning

* On simple projects, the WBS can be constructed
as a “tree diagram” or according to the logic
flow.

* The second method is to create a logic flow and
cluster certain elements to represent tasks and
projects.

e In the tree method, lower-level functional units
may be assigned to one, and only one, work
element, whereas in the logic flow method the
lower level functional units may serve several
WBS elements.

NEW CAR
DESIGN

BRAKES

ENGINE

STRUCTURE

INTERIOR

CHEMICAL

MECHANICAL

ELECTRICAL

Source: Kerzner, H. 2017. Project Management
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LEVELS

PROGRAM

PROJECT

TASK



Vevox questions
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Join at;
vevox.app

ID:
112-829-844
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Preparation of the also considers other areas that require
structured data, such as scheduling, configuration management,
contract funding, and technical performance parameters.

Budget
WBS
Risk analyis

Responsible matrix

vevox.app

ID:
112-829-844

EeaE
i

https://silesianuniversity.vevox.com/#/meeting/449222/polls

Which are typical problems related to the project planning?
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PART 2

MS Project WBS

Introducing the WBS in MS Project

a - = Gantt Chart Tools

Resource Repart Project View Format Q Tell me whz

X Cut . . . . = . = ﬂ Mark on Track -
Calibri 12 0 254 504 754 D0
. ER Copy - %7 Respect Links
aste - . =& | =
- ¥ Format Painter BII u O L =7 | == = Inactivate

Clipboard Font 7] Schedule

Task
wes + WBS + @  pode - | Task Name

0 0 4 Project Management for MS Website

1 1 4 |nitiating

11 4 Develop Project Charter
Identify Goals and Objectives
Develop Strategies and Plans
Research Previous Experience
Develop Project Charter

4 Develop Preliminary Project Scope
Statement

il il &l il &l

- N R TR TR ]

For orientation between tasks, it 1s
advisable to structure the project into
several phases, i.e. to create a
hierarchical structure of activities - WBS
(Work Breakdown Structure).

For easier orientation it is recommended
to insert a new column (right mouse
button in column header — insert new
column "WBS code", this will create a
sequential outline and de-composition of
the individual tasks.




MS Project WBS

When entering tasks sequentially, it 1s
necessary to create a "task indentation" to
achieve a task structure, e.g. a summary task
and this will consist of sub-tasks

For this procedure it is necessary to use two
icons on the Task tab namely Add Task
Indentation/Remove Task Indentation (icons
are formed by a green arrow).

See — an example

=

=]
Gantt
Chart -

View

W o = o

L R R

MS Praject - sample (5. Topic - lecture)... Gantt Chart Tools

3.;

Q Tell me

Task Resource Report Project View Format

[~}
N P i | - -
D E 0= 252 S0« T75x 002 A D
g - .+ -
Paste B IT U M-A-E = e oocs Manually  Auto
L] L e g
- 4 Schedule Schedule =7~
Clipboard Font ] Schedule Tasks
Task Outdent Task (Alt+Shift+Left)
WES - 0 Mode =  Task Mame ~ | Duration
———— Thistask may become a summary =~ ——
1] - 4 Project Mi i3}, 84 days?
1 - 4 [nitiating ) ) ) 7,5 days?
- Creating a hierarchy will help you 5
11 d 4 Devell petter organize your tasks. 3,5 days?
111 - ldenumy vuam anu wuecuves 1day?

Gantt Chart Tools

o -

Task

M5 Project - sample (5. Topic - lecture)...

o . -
L s

Resource Project View Help Format

"D % Calibri -1 -
Fg -

Report

EEEEE
Ox 25 50x 75% 100% b,
Paste B I U M-A- 5|5 sa ech Manually ~ Aute
L) = =
- ¥ 4 = Schedule Schedt
Clipboard Font ] Schedule Tasks
Task Indent Task (Alt+Shift+Right)
WES - 0 Mode « Task Name . 9 L
—————— This task becomes a subtask. e
0 - 4 Project Mana 8
1 - 4 Initiating Creating a hierarchy will help you 7
better organize your tasks.
1.1 - 4 Develop | 3
111 - Identify Goals and Objectives 1

o ob o o o ol o

Task
Mode

|
« Task Name
Phase #1
Task 1 =3
Task 2 =c:>

Scenario Tes =
Phase 2 Plan &
Phase#2 T
Task 3 =

|=
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TASK
o |% e _
4 Phase #1
Task 1
Task 2

Scenario Test Pass

Phase 2 Planning
4 Phase #2

Task 3



MS Project WBS

Project management focus: Top-down and
bottom-up planning

* Top-down planning This approach
identifies major phases or components of
the project before filling in all the details
required to complete those phases, which
are represented in the plan as summary
tasks. Complex plans can have several
layers of nested summary tasks. This
approach works from general to specific.

* Bottom-up planning This approach
identifies as many of the bottom-level
detailed tasks as possible before outlining
them into phases or summary tasks. This
approach works from specific to general.

H ©-

File
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,ﬁ A Gantt Chart Tools MS Project - sample (5. Topic - lecture) - Project Professional

Task Resource Report Project View Help Farmat Q Tell me what you want to do

m E‘]"GE‘tAdd-ll‘lS ﬂ u.:_l' I:I EB IEI E Status Date: 5] NA g:

Ef] Update Project

Subproject & My Add-ins - Project  Custom Links Between WBS Change Calculate  Set Move Spelling
Information  Fields Projects -  Waorking Time  Project Baseline - Project
Insert Add-ins Properties Schedule Status Proofing
Task 16 Jul 2
WBS - 0 Meode ~ | Task Name ~ | Duration - Start ~ | Finish ~ | Pre F s s M T w T F
23 |2.24 - Documen t Assumptions % days Fri14.07.23 Fri14.07.23 22 {14.0?
24 123 - 4 Develop Project Schedule 5 days? Fri14.07.23 Fri21.07.23 19 T T
25 1231 - Build Work Breakdown Structure 1day? Fri 14.07.23 Mon Project Manager
17.07.23
26 [2.3.2 - Develop Resource Plans 1day? Mon 17.07.2; Tue 18.07.23 25 lPrnjeCt Manager
27 |2.3.3 L] Prepare Project Estimates 1day? Tue 18.07.23 Wed 19.07.2 26 lProject Manager
28 |2.34 - Define Dependencies and Develop 1day? Wed Thu 20.07.23 27 Project|M:z
Project Schedule 19.07.23 l
29 1235 - Document Assumptions 1day? Thu 20.07.23 Fri 21.07.23 28 Pr
024 - 4 Develop Risk Plans 3 days? Fri 21.07.23 Wed 26.07.2 24 —
31 241 - Document Risk Management Plan 0,5 days? Fri 21.07.23 Fri 21.07.23
32 (242 - Identify Risks 1day? Mon 24.07.2: Mon 24.07.2: 31

Creating accurate tasks and phases for most complex plans
requires a combination of top-down and bottom-up planning.
Typically, a project manager begins with established, broad
phases for a plan (top-down planning), and the resources who
will execute the plan provide the detailed tasks that fill out
each phase (bottom-up planning).



MS Project WBS
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In this way you create a sequential WBS (the corresponding column called "WBS
code") of your entire project.

E ()- 1 * = Gantt Chart Tools

Resource Report Project View Format Q Tell me

H ©- % - = MSProject-sample (5. Topic - lecture)..  Gantt Chart Tools oy -
Cut - Mark on Track
- &+ = MSProj le (5. Tc I8 Reouce  Report  Project  View  Help Format Q Tell me wf M Calibri A WEESRR
MS Praject - sample (5. & 7 7 MSProject-sample (5. Top| - p paste B Copy 9 Respect Links
o x : . antt  Paste ) TUuldH-A- |55 o )
: Resource  Report  Project V| D Calibri L4 @, Chart~ - ¥ Format Painter A = Inactivate
Resource Report Project Gt Pate . (g I U Auto View Clipboard Font [ Schedule
% = = - Chart= - = Sehecing | - e
C- % S = Bg - sl 0z 25 View  Clipboard Font [ Schedule Tasks WBS « wes » @ Mode = | Task Name - D
D o Calibri 12 - N Paste B I U - Task 0 - 4 Proj i
o - A WS - | WBS v | O | \Viode - TaskName . D o [1] = Project Management for MS Website 8
Gantt  Paste Calibri = [] ™ I T 1 - 4 Initiatin 7,
o Calibri - o Clipboard ot : 0 WBS " for MS Website 84 o —-) ;g ——
arc~ - 1 Contains work breakdown structure  [ing 7.t 11 1.1 = 4 Develop Project Charter 3,
B I Task A i .
View Clip Mode + Tas 2 g‘,:iﬂf::;("::‘;::y’:u conuseto [E1OP Project Charter 3t 3 111 111 - Identify Goals and Objectives 1
| = 0 aF 3 LL1 | represent the associated task's dentify Goals and Objectives e 4 112 112 - Develop Strategies and Plans 1
[ ' =k WES 4 |112 | positionwithin the hierarchical develop Strategies and Plans 1c 5 L1z 113 - & h Previous Experi N
WB % Cut n_de ~ Task Man 1 |\WES Predecessors 5 (e structure of the project. Research Previous Experience 1c 1. =3 esearch Previous Experience
0 0 E . P Proje 2 |WBS Successors 6 |Lra |uia - Develop Project Charter 0.: 6 .14 114 - Develop Project Charter 0,
B opy 'Work .1 1. a o -
5 opy B 3 |work Contour 7 |12 a2 - 4 Develop Preliminary Project Scope ac 7Lz 12 - 4 Develop Preliminary Project Scope 4
T &D Paste 4 Init A Wark Variance & Statement Statement
2 |11 ) ol 112 8 |121 |21 = Conduct Planning Workshop 1c 8 121 121 - Conduct Planning Workshop 1
: 1 Paste Special... 3 113 113 9 122 [1.2.2 - Document Project Costs and Benefits 0, 9 122 122 - Document Project Costs and Benefits 0,
1.1.: i
| gg Wrap Text 6 1.1.4 114 10 [2.23 .23 - ?teviop High Level Work Breakdown 1c 0123 123 - Develop High Level Work Breakdown 1
4 |1.1. — 7 ructure Structure
" Insert Col 12 12 1 |124 [124 - Conduct Peer Review 1c o - g
| nsert Column 2. .2, i
3 . = 12 1125 [1.25 - Prepare Preliminary Project Scope [ 124 124 2 Conduct Peer Review 1
6 | LXJ Hide Column ] 121 121 Statement 12 1125 125 - Prepare Preliminary Project Scope 0,
1'1': - 9 1.2.2 122 s B2 2 - 4 Planning 27 Statement
7 |12 A Font. a[ 0 123 123 g 1421 21 - 4 Set Up Project Environment ac = B2 2 - 4 Planning 2
15 211 [211 - Prepare Facilities 1c < 14 - 4 i i .
< E id P I 2.1 21 3 Set Up Project Environment a
1 'ei Text Styles... o 124 124 - Z 16212 [212 - Set Up Project Standards and Procedures  1c¢ Y995 211 211 - Prepare Facilities 1
8 |12 - . e e d Y17 213 13 - Set Up Project Management Tools ic = .
| D Field Settings 12 - Z 16 212 212 - Set Up Project Standards and Procedures 1
9 |1.2: 125 125 5 18 214 [2.14 - Set Up Project Book 1c g - B
o I:I Custom Fields 19 |22 L2 - 4 Define Scope . 17 1213 213 - Set Up Project Management Tools 1
10 1.2 = 13 2 2 - 20 221 [2.21 - Document Scope Management Plan ic £ 214 214 - SetUp Project Book 1
< i 21 21 = 21 222 |22 - Specify Deliverables and Acceptance 1c 1922 22 - 4 Define Scope 4
Criteria 0 221 221 - Document Scope Management Plan 1
11 (124 |1.24 L= 2 15 211 211 -
2 £ 22 1223 23 = Define Scope 1e 21 222 222 = Specify Deliverables and Acceptance 1
12 |1.2.5 1.2.5 - g 16 212 212 - 23 224 |2.24 - Document Assumptions 1c Criteria
7 24 - i
17 213 213 - a 23 |23 —.. 4 DWE::' ProJ:ftSC:zdule 5¢c 22 223 223 - Define Scope 1
18 214 214 - 231 [231 ) Build Work Breakdown Structure 1c . - .
= 13 |2 2 - 4 Plal 2 (232 [|232 - Develop Resource Plans 1c 224 (224 2 Document Assumptions
-3 19 2.2 2.2 - R R — - oo . 24 23 23 - 4 Nevelon Proiect Schedule 5




MS Project WBS
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Gantt Chart Tools MS Project - sample (5. Topic - lecture} - Project P
s ° s s s Resource Report Project View Farmat Q Tell me what you want to do
For orientation in the project, the WBS i1s
_'_| Ly X Cut Calibri S - ? g % g 5 ﬂ Mark on Track ~ % '7 F E\?
d h t k d == D ER Copy - _. _ T e Respect Links - 2 v
uscd, wnere summary tasks arc create C.g. ot Ppae Ml u HeA- T s @ _ Auto  Inspect Move Mode Task
5 Chart = = ~ Format Painter - RN £ Inactivate Schedule - < o =
: View Clipboard Font [F} Schedule Tasks Insert
points 1, 2, etc.), under them there are sub- .
. . . WBS ~ 0 Mode ~ Task Name w | Duration » Start ~ Finish v Pre F s s M T v
tasks (aCtIVItleS) e.g. 2 1 2 1 . 1 . 0 lo L L 4 Project Management for MS Website 84 days? Mon 26.06. Thu 19.10.2 :
? ’ 11 o = I Initiating 7,5days?  Mon 26.06.2 Wed 05.07.2 u—
13 |2 o = 4 Planning 27 days? Wed 05.07.2 Fri11.08.23 1 3
14 |21 N = 4 Set Up Project Environment 4 days? ‘Wed 05.07.2 Tue 11.07.23
15 2121 S0 = Prepare Facilities 1day? ‘Wed 05.07.2 Thu 06.07.23
. . . . . 16 - : \ -
ThlS 1S a pI'aCtlcal appllcatlon Of the ‘MB S on a ' 212 (W [wm SetUp Pro!ectstandardsand Procedures |1 day? Th_u 06.07.23 Fri 07.07.23 | 15
213 [ = Set Up Project Management Tools 1 day? Fri07.07.23 Mon 10.07.2; 16
: : 18 214 S = Set Up Project Book 1day? Mon 10.07.2 Tue 11.07.23 17
prOJ eCt exampleﬂ Where you have a SpeCIﬁC 19 (2.2 o = I Define Scope 4 days? Tue 11.07.23 Mon 17.07.2 14
bl k d d b 24 |23 o= 4 Develop Project Schedule 5 days? Mon 17.07.2 Mon 24.07.2 19
prO em (tas ) an you nee more Su = 25 (231 W = Build Work Breakdown Structure 1day? Mon 17.07.2; Tue 18.07.23
o« e, . . . 26 (232 W = Develop Resource Plans 1day? Tue 18.07.23 Wed 19.07.2 25
aCtIVItleS tO SOlve lt, SO break lt down lnto 27 233 W = Prepare Project Estimates 1 day? ‘Wed 19.07.2 Thu 20.07.23 26
. . . o 28 234 W = Define Dependencies and Develop 1day? Thu 20.07.23 Fri21.07.23 27
individual "working packages". AAC S
29 235 W = Document Assumptions 1day? Fri21.07.23 Mon 24.07.2: 28
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Task mode
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Join at:
vevox.app outdent task and indent task
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@ . Use short verb phrases that describe the work to be done. The
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task description

resource creation
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* Tasks are the most basic building blocks
PART 3 of any project’s plan.

VR e QU VAR SRR LI E U B «  Tasks represent the work to be done to

accomplish the goals of the project.
Demonstration of how to create tasks,

define the duration of each task.

nnnnnn

e Tasks describe work 1n terms of
P ———— dependencies, duration, and resource
" 25: 5::57 IW/:B %Rapecthks .
e requirements.

Task
wes ~ @ piode - TaskName

+  Duration = Start
0 |o - 4 Project Management for MS Website 84 days? Mon 26. Y I M P . h 1 k : f
A i o n roject, there are several kinds o
2 |11 - < Develop Project Charter 3,5 days? n 26.0
3 |11a - Identify Goals and Objectives 1day? M
B e = e ot a sl tasks. These include summ ary tasks,
5 [1.13 - Research Previous Experience 1day?
6 |1.14 - Develop Project Charter 10,5 days? b k d . 1
T |12 -y 4 Develop Preliminary Project Sco 4 days?
- | e rmiary et sape : subtasks, and milestones.
8 [1.21 - Conduct Planning Workshop 1day?
9 [1.2.2 - Document Project Costs and Benefits 0,5 days? ri
10 1.2.3 - Develop High Level Work Breakdown 1day?
Structure
11 1124 - Conduct Peer Review 1day?
12 1125 - Prepare Preliminary Project Scope 0,5 days? . .
* What are called fasks in Project are
= 13 )2 - 4 Planning 27 days? r aS S ln r J r
% 14 121 - 4 Set Up Project Environment 4 days? .
15 211 - Prepare Facilities 1day?
L o - [ sometimes more generally called
Y7 |23 - Set Up Project Management Tools 1day?
18 [2.1.4 - Set Up Project Book 1day? * *q°
S =~ ([ activities or work packages.
20 12,21 - Document Scope Management Plan 1day?
Sascifnalivarahles and dccantance 4




Create tasks

Tasks represent the work to be done to
accomplish the goals of the project. Every
task 1n a plan 1s given an ID number, but the
number does not necessarily represent the
order in which tasks occur.

Every task in Project has one of two
scheduling modes that controls how the task
1s scheduled: manual (the default) or
automatically scheduled.

Think of a manually scheduled task as an
initial placeholder you can create at any time
without affecting the rest of the schedule.

Task names should be recognizable and
make sense to the people who will perform
the tasks and to other stakeholders who will
read the task names.

SILESIAN
UNIVERSITY

SCHOOL O BUSINESS

To enter task names ADMINISTRATION IN KARVINA
1. Click an empty cell in the Task Name
column.

2. Enter your task names, and then press
the Enter key after each one.

To insert a new task within a task list

1. Click in the Task Name column where - >
you want to insert the new task. :
2. On the Task tab, in the Insert group, g
click Task. - o
Project inserts a row for a new taskand -2 = = fi:::‘j::fgg};;;:;:;; ;;;;; Cimon
renumbers the subsequent tasks. i

Project Bl
names the new task <New Task>. :
3. With <New Task> selected, enter the ..~
task name, and then press Enter. -
To delete a task

1. Right-click the task name, and then

click Delete Task.

ko
WeS | @ pMoge ~ | TaskName + Duration - |Start - Finish  ~ Pred

4 Project Management for MS Website 84 days? Mon 26.06. Thu 19.10.2
4 Initiating 7,5 days? Mon 26.06.2 Wed 05.07.2
4 Develop Project Charter 3,5 days? Mon 26.06.2 Thu 29.06.23

Develop Strategies and Plans 1day?

133 23334334
X

A333333848 a3



Enter task durations and dates

A task’s duration represents the amount of
time you expect it will take to complete the
task. Project can work with task durations
that range from minutes to months.

Project uses standard values for minutes and
hours for durations: 1 minute equals 60
seconds, and 1 hour equals 60 minutes.

For the durations of days, weeks, and
months, you can use Project’s defaults (for
example, 20 days per month) or define your
own values 1n the Project Options dialog
box.

File

Task Resource Report Project

w ) Get Add-ins |_—‘
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MS Praoject - sample (3. To|

Gantt Chart Tools

Format Q Tell me what you want to do

3 ABC
ﬁ_.” I:l '__CDL Status Date: [72] NA
= il Update Project

Subproject 3 My Add-ins - Project  Custom Links Between WBS Change Calculate Set Move Spelling
Information Fields  Projects - Working Time  Project Baseline Project
Insert Add-ins Properties Schedule Status Proofing
Task 25 Jun
wes -~ | @  peode - TaskName + Duration ~ Start  ~ Finish ~ P F 5 5
0o - # Project Management for MS Website 84 days? Mon 26.06. Thu 19.10.2
1 1 - i Initiating 7.5 days? Mon 26.06.2 Wed 05.07.2
B3 2 Project Options ? X
General =
Change options related to scheduling, calendars, and calculations.
Display
7213 Schedule Calendar options for this project: | 5] MS Project - sample (5. To... ~
P Proj )y P!
Beis Proafing Week starts on: Sunda; i
19 22 SLEEE starts B Y
4 23 Save FEiscal year starts in: | January i
55 231 Language
26 |2.3.2 Advanced Default start time: | 800~ These times are assigned to tasks when you enter a start or finish date
= without specifying a time. If you change this setting, consider
7 1233 Customize Ribbon Default endtime: | 17:00 ~ matching the project calendar using the Change Working Time
% 234 Hours per day: 3 = command on the Project tab in the ribbon.
Quick Access Toelbar B -
2 Hours perweek: 40 z
9 1235 Add-ins =
= 30 fedn Days per month: 20 -
g 024 Trust Center
E 31241 Schedule
32 242
E Shaw scheduling mess
g B 243 I .
ow assignment units as a: ercentage ¥
M 244 259 9
B 28 Scheduling options for this project: | 5] MS Project - sample (5. To.. ~
36 251
7 26 New tasks created: Auto Scheduled A
32 264 Auto scheduled tasks scheduled on: | Project Start Date
3 (262 Duation is entered in: Days <
a0 2.7 Work is entered in: Hours  ~
41 1271 Default task type: Ficed Units
42 272 MNew tasks are effort driven C Tasks will always henor their constraint dates C
4 273 utolink inserted or moved tasks (0 Show that scheduled tasks have estimated durations
#4274 Split in-progress tasks (& [] New scheduled tasks have estimated durations
43 1275 Update Manually Scheduled tasks [] Keep task on nearest working day when changing to
when editing links Automatically Scheduled mede
46 28
47 281 Schedule Alerts Options: | @5 MS Project - sample (5. To.. ~
48 2.8.2 Show task schedule warnings
48 29 [] Show task schedule suggestions >
] | Cancel
Busy = New T
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Assume that a plan has a project calendar with
. . ) . With a setting of 8 hours per day,
workmg time defined as 8:00 A.M. through 5:00 artering atwosdny tasledimationd]
P.M., with one hour off for lunch breaks, Monday is the same as entering 16 hours (16h)
through Friday, leaving nonworking time defined
as evenings (after 5:00 P.M.) and weekends.
S |€i Change options related toscheduling, calendars, and calculations. .
Display
If you estimate that a task will take 16 hours of Schedule Calendar options for this project: [i3 Project! g
working time, you could enter its duration as 2d | "™ Wedsmnor:  (Sody [
Save Fiscal year starts in: |January |+
to schedule work over two 8-hour workdays. ——
Advanced Default start time: | 8:00 AM | | :'1;&5: ;TE étr; ﬂﬁt-'-igqﬂﬂ_iflt._c tcsk:_ '—‘aﬁeirf!_::'cu Egtew ;t;r‘fcr
. Castoiice Ribice Default end time: | 5:00 PM ~ | :-r:t‘t_ing_. ccm.;i?l&r ml;:::hiﬂ"g tEr: prcj;:t cr\alencliar uginglf ti‘IE
YOU ShOUld then CXpeCt that Startlng the taSk at T Hours per day: g : ﬁ:;:ge Working Time ceommand on the Project tab in the
8:00 A.M. on a Friday means that it will not be . Hours per week: |40 =%
. . ays per month: |20 ~+
completed until 5:00 P.M. on the following Trust Center G -
Monday. No work would be scheduled over the _ _ : _ _
With a setting of 20 days per month, With a setting of 40 hours per week,
weekend because Saturday and Sunday have been entering a one-month task duration (1mo) entering a three-week task duration (3w)
defined as nonworking time. is the same as entering 160 hours is the same as entering 120 hours (120h)

(8 hours per day x 20 days)



Enter task durations and dates
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* Project handles task scheduling in two ways. scH00L OF BUSINESS

ADMINISTEATION IM KAEYINA

E € - fg- = Gantt Chart Tools

* Automatically scheduled tasks always have a duration (one day by ek reore s BB e e feme O Tamesteymnniede
default). B s H | BB By B pemebn 7

Ef] Update Project

Subproject & My Add-ins - Praject CL!ST:UFH LmksE.Etwaan WES Change Calculate SFT‘t Mu.ve Spelling
Information  Fields Projects ~  Working Time  Project Baseline - Project
Insert Add-ins Properties Schedule Status Proofing
Task
WES ~ 9 Mode v Task Name ~ Duration + Start ~ | Finish v Pre T
. o . . O o b 4 Project Management for MS Website 84 days? Mon 26.06. Thu 19.10.2
e Manually scheduled tasks, however, do not initially have any duration. A s = iy 5t Mon 662 Wedosana
13 2 - 4 Planning 27 days? ‘Wed 05.07.2 Fri11.08.23 1
b < b < < . 4 21 - 4 Set Up Project Environment 4 days? Wed 05.07.2 Tue 11.07.23
task’s duration 1s essential for Project to schedule a task, so it makes sense e . der?  Wed oSt s
. . . 16 2,12 L Set Up Project Standards and Procedures  1day? Thu 06.07.23 Fri07.07.23 15
that a manually scheduled task, which is not scheduled by Project, does s 0w SetUp rjecManagementTools  1day? #0701 on 10072 1
18 214 - Set Up Project Book 1day? Maon 10.07.2 Tue 11.07.23 17
: : 19 22 - > Define Scope 4 days? Tue 11.07.23 Mon 17.07.2 14
not require a duration 5 W = .
° 412, 5 4 Develop Project Schedule 5 days? Mon 17.07.2 Mon 24.07.2 19
25 |2.3.1 L Build Work Breakdown Structure 1day? Mon 17.07.2; Tue 18.07.23 me'
26 232 -
Task Information s
a7 |2.3.
28 zzi :: Genera | Prede:essorsl Resourcesl Advancedl Motes | Custom Fle\dsl
) Y h pl h ld d : l f lly - Mame: | Build Work Breakdown Structure Duration: | 1 day? : Estimated
ou can, however, enter placeholder duration values for manua RN et S
< Schedule Mode: (®) [l
scheduled tasks BN
: z . Dates
If you enter this 3 i i':'z : Start: | Mon 17.07.23 | Finish: [ Tue 18.07.23 -
abbreviation It appears like this And it means = I¥ =
DDlsplayoanelme
m (such as 30m) 30 mins 30 minutes 1251 | Dtiice gar
328 - [Jroliup
h (such as 6h) 6 hrs 6 hours 381261 2
39 262 -
d (such as 4d) 4 days 4 days @127 9
491 271 -
w (such as 3w) 3 wks 3 weeks 42 272 = HE =
41 lama - e E Pt bl Pl e e 1 ded Th..M7 AB AA T na na An an

mo (such as 2mo) 2 mons 2 months
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* When you create an automatically scheduled task, Project adds a question
mark (?) after the one-day duration to indicate that the duration 1s an
estimate.

Gantt Chart Toals

Q Tell me what you want to do

View Help Format

* This is a handy reminder that you will need to determine the task’s correct i eoomn o o) [ B By @ [ |
duration at some point. e e e e R
In fact, you can flag any task as having an estimated duration. Select the oo » = “Mmfmw., i u;" wonzome T 07—
task, and on the Task tab, in the Properties group, click Information, and T R SRy T— maw _asamn
then sect the Estimated check box. ol EELL.E SRR
If needed, you can schedule tasks to oceur during nonworking and i EEEETT D SRR
working time. To do this, enter an elapsed duration to a task. You enter L N e— T B
elapsed duration by preceding the duration abbreviation with an e. R e —

For instance, a construction project might have the tasks Pour foundation concrete and E : D‘Y 7

Remove foundation forms. If so, you might also want a task called Wait for concrete to & » =2 = =

cure, because you don’t want to remove the forms until the concrete has cured. The task = E e B )

Wait for concrete to cure should have an elapsed duration because the concrete will Sa DS

cure over a contiguous range of days, whether they are working or nonworking days. If E

the concrete takes 48 hours to cure, you can enter the duration for that task as 2ed, e W -

schedule the task to start on Friday at 9:00 A.M., and expect it to be complete by
Sunday at 9:00 A.M
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1. Click a cell in the Duration column for a task.

2.  Enter a duration value.

M5 Praject - sample (5. Topic -

Q Tell me what you want to do

) Get Add-ins

* Project initially sets all new tasks that have a duration O | B - )
value to start at the project start date. This 1s true whether s @ R e . e
the tasks are manually or automatically scheduled. E Mm o m E“ ‘:m

- For manually scheduled tasks, you can enter a duration as | = & = s ler wsesmees
either a numeric value, such as 2d, or as placeholder text, S Rt v
such as Check with Marketing team. For any columns that 178 : W““ iﬂi‘% sonsrors oot _H
are too narrow to display the full value, point to the cell; its L _ — W
full value will appear in a ScreenTip. Cwwe n o= T T

*  For both manually and automatically scheduled tasks, T T S e L

Project draws a Gantt bar in the chart portion of a Gantt
chart view. The length of the bar represents the task’s
duration.
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Enter milestone tasks RO OF M s
* In addition to entering tasks to be completed,
you might want to account for an important e - K Format Q) Tl me ot youvant o do
event for your project’s plan, such as the end W oo gl O] B EEBBZE

Ef] Update Project

H ©- 3 - 5 Gantt Chart Tools MS Project - samp

Subproject & My Add-ins - ProjecF CL!StDI’T‘I Links B.etween WEBS Change Calcglate Sgt Mqve Spelling
. . . Information  Fields Projects *  Waorking Time  Project Baseline = Project
of a major phase of the project. To do this, you
: < wes .| O I..a::e +  Task Name ~ Duration « | Start + Finish ~ Pre| F s
Wlll Create a mlleStone taSk' 0 o - 4 Project Management for MS Website 83 days? Mon 26.06. Wed 18.10.
1 11 - > Initiating 7,5 days? Mon 26.06.2 Wed 05.07.2
13 (2 - 4 Planning 26 days? Wed 05.07.2 Thu 10.08.23 1
14 (21 - 4 Set Up Project Environment 4 days? Wed 05.07.2 Tue 11.07.23
. . . 15 211 - Prepare Facilities 1day? Wed 05.07.2 Thu 06.07.23
* Milestones are significant events that are iz W = Set Up ProjectStandards and Procedures 1day?  Th06.07.23 Fri0r07.23 15
. . . 17 213 - Set Up Project Management Tools 1day? Fri07.07.23 Mon 10.07.2; 16
either reached within the plan (such as the ©21s 0 m Set Up Project Book Lday?  Mon10.07.2 Tue 110723 17
. . 19 122 - 4 Define Scope 3 days? Tue 11.07.23 Fri 14.07.23 14 _ﬂ
Completlon Of a phase Of Work) Or lmposed 20 (2.21 - Document Scope Management Plan 1 day? Tue 11.07.23 Wed 12.07.2 ag
21 (2.2.2 - Specify Deliverables and Acceptance 1 day? wed Thu 13.07.23 20 yjectManager
upon the plan (such as a deadline by which to
22 12.2.3 - Define Scope 1 day? Thu 13.07.23 Fri14.07.23 21 7+ Project M.
. . 23 204 | wm Document Assumptions B days lFrita.07.23 Friza07.23 22 & 1407
apply for funding). Because the milestone e T Star? Triares |miims o] 1
. ° . 25 (231 - Build Work Breakdown Structure 1day? Fri 14.07.23 Mon
itself doesn’t normally include any work,
e
milestOneS are normally represented as tasks E ;? 2.3.2 - Develop Res_ource I_Jlans 1day? Mon 17.07.2; Tue 18.07.23 25
z 7233 - Prepare Project Estimates 1 day? Tue 18.07.23 Wed 19.07.2 26
Y 2 234 - Define Dependencies and Develop 1day? Wed Thu 20.07.23 27

With ZerO duration. Project Schedule 15.07.23

29 235 Document Assumptions 1day? Thu 20.07.23 Fri 21.07.23 28
30 24 4 Develop Risk Plans 3 days? Fri21.07.23 Wed 26.07.2 24

ai
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*  When you link tasks, you create scheduling relationships between the tasks.

* These task relationships are called dependencies, as in the start of this task 1s dependent upon the
completion of a prior task. When you create task dependencies (also called links), Project can
automatically adjust the scheduling of linked tasks as changes occur in your plan.

* Creating dependencies by linking tasks is crucial to getting the full benefit of the Project
scheduling engine.

These two tasks have a finish-to-start relationship, which has two aspects:
* The second task must occur after the first task; this is a sequence.
* The second task can occur only if the first task 1s completed; this is a dependency.



Enter task durations and dates

Link tasks to create dependencies
e Click View > Gantt Chart.

* Hold down Ctrl and click the two tasks you
want to link (in the Task Name column).

 C(Click Task > Link the Selected Tasks Link
Tasks button on the Task tab of the ribbon.

File

=
Gantt
Chart ~

View

23
24
25

26
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Task Resource Report Project View Help Format Q Tell me what you want|
X Cut L - = = . EMarkonTrack <
D Calibri |11 =] 0 25k S0x vse inox y,
. Egy Copy ~ @Rspect Links " T
aste - - 5 = ua =5 anua
- % Format Painter B I Uu O A - == &c2 = |nactivate Scheduli
Clipboard Font [F] Schedule
o Task Link the Selected Tasks (Ctrl+F2)
WBS ~ Mode ~  Task Name
You can link tasks so one can't start =
2,24 - Document Assumptions until the ether has finished. 7.
23 - 4 Develop Project Schedule 7.
5 You can also link tasks in other
2.3.1 - Build Work Breakdown Struct ways, such as a Start-to-Start link 7.
when two tasks need to start at the
same time.
2.3.2 - Develop Resource Plans 1day? Mon 17.0
Task
Maode - | Task Mame -
= 4 Phase #1
I
= Task 1 —
= Task 2
= Scenario Tes! _L
sk Plant
== ¥ N N N - [
- e 25¢ S0 TS (00w
= = . s
«=> == |@®py I



Gantt chart with tasks and durations — an example

Gantt

Chart

View

GANTT CHART

-

23
24
25

26
27
28

29
30
31
32
33
34
35
36
37
38
39
40
41

Gantt Chart Tools

M5 Project - sample (5. Topic - lecture) - Project Professional

Resource Report Project View Format Q Tell me what you want to do
&D ?{)Cut Calibri i o] ----—- ﬁMarkonTrack b 3 % '7 B E\? '|'. 'Ill_l 'l# E . my A Find ~
Paste EE Copy ~ = = i =14 G9 Respect Links Manuall Auto Inspect Mowve Mod-e Task Surmmary Milestone Information ;l Detalls Scrall S
- ~ Format Painter b0 - A M € ¥ | @ = Inactivate Scheduli Schedule 3 = = = v r-|-_‘:.'..\3\|:i|:i to Timeline to Task Fill =
Clipboard Font [F] Schedule Insert Properties Editing
WBS ﬁ I:;l;e ~ | Task Name Duration ~ Start ~  Finish ~ Pre s . JSLII - M T w T F s . JSL” - M T w T F
224 - Document Assumptions 0 days Fri 14.07.23 Fri 14.07.23 22
23 - 4 Develop Project Schedule 5 days? Fri 14.07.23 Fri 21.07.23 19
231 - Build Work Breakdown Structure 1day? Fri 14.07.23 Mon
17.07.23
23.2 - Develop Resource Plans 1day? Mon 17.07.2: Tue 18.07.23 25
2.3.3 - Prepare Project Estimates 1day? Tue 18.07.23 Wed 19.07.2 26
234 - Define Dependencies and Develop 1day? Wed Thu 20.07.23 27 nager
Project Schedule 19.07.23
2.3.5 - Document Assumptions 1day? Thu 20.07.23 Fri 21.07.23 28 )ject Manager
2.4 - 4 Develop Risk Plans 3 days? Fri 21.07.23 Wed 26.07.2 24 0
241 - Document Risk Management Plan 0,5days?  Fri21.07.23 Fri 21.07.23 r;Acceptor
242 - Identify Risks 1day? Mon 24.07.2: Mon 24.07.2; 31 lProject Manager
24.3 - Analyze Risks 1day? Tue 25.07.23 Tue 25.07.23 32 lP ect Manager
244 - Document Risk Management Plans 0,5days?  Wed 26.07.2 Wed 26.07.2 33 Project Manager; Acceptor
2.5 - 4 Plan for Quality 0,5 days? Wed 26.07.2 Wed 26.07.2 30
251 - Document Quality Management Plan 0,5days?  Wed 26.07.2 Wed 26.07.2 Quality Assurance Manager;Acceptor
2.6 - 4 Organize Project Resources 2days? Thu 27.07.23 Fri 28.07.23 35 I T
2.6.1 - Develop Organization Structure 1day? Thu 27.07.23 Thu 27.07.23 lPrOJ'ed Director
2.6.2 - Develop Staffing Plan 1day? Fri28.07.23 Fri 28.07.23 38 Project Di r
27 - 4 Develop Procurement Plans 4,5 days? Mon 31.07.2 Fri 04.08.23 37 I T
-y Contracts Manager

271

Determine Procurement Requirements

1day?

Mon 31.07.2: Mon 31.07.2.

i)

P TP
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You can record additional information about e o o e - scioot of pusINESS
a task 1n a note. =, %o il . e S VakonTad - -

3 - 3 Gantt Chart Tools

contt | P 9 ER Copy ~ . . % Respect Links I\-"I/ i |

ChaaﬂrtY av ¢ ' Format Painter Uy O - A T e | @0 = Inactivate S.cahnel:izli Sch:d(l.).lle
View Clipboard Font ~ Schedule Ta:

Task

. . WBS ~ 0 Mode = Task Name ~  Duration - Start ~  Finish
FOr example, y0u mlght have detalled 0o - 4 Project Management for MS Website 83 days? Mon 26.06. Wed !
. . 11 N = > Initiating 7,5days?  Mon 26.06.2 Wed 0
descriptions of a task but want to keep the ST pr— x ]9
421 11
task,s name SuCCinCt 15 1211 Generall Predecessorsl Resourcesl Advanced ________ N OtES ______ Custam Fieldsl he
‘ 16 [2.1.2 Mame: | Initiating Duration: | 7,5 days : Estimated 7.
17 |2.1.3 Motes: 1
12 |214 ‘ B =1 M 11
19 22 D A.(

The Initiating Stage does the preliminary anatysis to define the project objectives and ensures that further project work is

You can add such details to a task note 2221 1 famoresa

2.2.2 13

rather than to the task’s name. That way, the 2 223

23 224 1.(

information resides in the plan and can be “ 23

23 231

. . . - .
easily viewed or printed.
g 2 232 18
Z 27 233 Help Cancel 1
Y 28 (234 LS Define Dependencies and Develop Tday? Wed Thu 20

Proiect Schedule 19.07.23

There are three types of notes: task notes,
resource notes, and assignment notes.
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e EA— Every task in Project has one of two scheduling modes that controls
how the task is scheduled:

Vevox questions

Join at:
vevox.app

ID:
112-829-844

Refim celé obrazovky ukonéte stisknutim kiavesy | Klivess Esc ‘
SILESIAN
UNIVERSITY
e - represents the amount of time you expect it will take to
complete the task.

A task’s duration

A milestones

Join at: A budget
vevox.app

ID:
112-829-844

[Of0]

A summary tasks

https://silesianuniversity.vevox.com/#/meeting/449222/polls
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The project manager is the key to successtul project planning. It 1s desirable that the project e b

manager be involved from project conception through execution. o

Project planning must be systematic, flexible enough to handle unique activities, disciplined
through reviews and controls, and capable of accepting multifunctional inputs. Successful
project managers realize that project planning is an iterative process and must be performed
throughout the life of the project.

One of the objectives of project planning 1s to completely define all work required (possibly
through the development of a documented project plan) so that it will be readily identifiable
to each project participant. This is a necessity in a project environment because:

— If the task is well understood prior to being performed, much of the work can be preplanned.

— [If the task is not understood, then during the actual task execution more knowledge is gained that,
in turn, leads to changes in resource allocations, schedules, and priorities.

— The more uncertain the task, the greater the amount of information that must be processed in
order to ensure effective performance.



